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  The information in this document is current as of June, 2003. The information is subject to change 
without notice. For actual design-in, refer to the latest publications of NEC Electronics data sheets 
or data books, etc., for the most up-to-date specifications of NEC Electronics products. Not all 
products and/or types are available in every country. Please check with an NEC Electronics sales 
representative for availability and additional information. 

  No part of this document may be copied or reproduced in any form or by any means without the prior 
written consent of NEC Electronics. NEC Electronics assumes no responsibility for any errors that may 
appear in this document. 

  NEC Electronics does not assume any liability for infringement of patents, copyrights or other intellectual 
property rights of third parties by or arising from the use of NEC Electronics products listed in this 
document or any other liability arising from the use of such products. No license, express, implied or 
otherwise, is granted under any patents, copyrights or other intellectual property rights of NEC Electronics 
or others. 

  Descriptions of circuits, software and other related information in this document are provided for 
illustrative purposes in semiconductor product operation and application examples. The incorporation of 
these circuits, software and information in the design of a customer's equipment shall be done under the 
full responsibility of the customer. NEC Electronics assumes no responsibility for any losses incurred by 
customers or third parties arising from the use of these circuits, software and information. 

  While NEC Electronics endeavours to enhance the quality, reliability and safety of NEC Electronics 
products, customers agree and acknowledge that the possibility of defects thereof cannot be eliminated 
entirely. To minimize risks of damage to property or injury (including death) to persons arising from 
defects in NEC Electronics products, customers must incorporate sufficient safety measures in their 
design, such as redundancy, fire-containment and anti-failure features. 

  NEC Electronics products are classified into the following three quality grades: "Standard", "Special" and 
"Specific". 
The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-
designated "quality assurance program" for a specific application. The recommended applications of an 
NEC Electronics product depend on its quality grade, as indicated below. Customers must check the 
quality grade of each NEC Electronics product before using it in a particular application. 
"Standard": Computers, office equipment, communications equipment, test and measurement  
  equipment, audio and visual equipment, home electronic appliances, machine tools,  
  personal electronic equipment and industrial robots. 
"Special": Transportation equipment (automobiles, trains, ships, etc.), traffic control systems,  
  anti-disaster systems, anti-crime systems, safety equipment and medical equipment  
  (not specifically designed for life support). 
"Specific": Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control  
  systems, life support systems and medical equipment for life support, etc. 

The quality grade of NEC Electronics products is "Standard" unless otherwise expressly specified in NEC 
Electronics data sheets or data books, etc. If customers wish to use NEC Electronics products in applications 
not intended by NEC Electronics, they must contact an NEC Electronics sales representative in advance to 
determine NEC Electronics' willingness to support a given application. 

(Note) 
(1) "NEC Electronics" as used in this statement means NEC Electronics Corporation and also includes its majority-owned 
subsidiaries. 
(2) "NEC Electronics products" means any product developed or manufactured by or for NEC Electronics (as defined 
above). 
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Regional Information 
Some information contained in this document may vary from country to country. Before using any NEC product 
in your application, please contact the NEC office in your country to obtain a list of authorized representatives 
and distributors. They will verify: 

  Device availability 

  Ordering information 

  Product release schedule 

  Availability of related technical literature 

  Development environment specifications (for example, specifications for third-party tools and 
components, host computers, power plugs, AC supply voltages, and so forth) 

  Network requirements 

In addition, trademarks, registered trademarks, export restrictions, and other legal issues may also vary from 
country to country. 
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CHAPTER 1 INTRODUCTION 

The 78K0R–Link It! demonstration kit for the NEC low power 78K0R 16-bit microcontroller family is designed 
as a development platform for IO-link sensors, and can also be used as an evaluation tool for the 78K0R 
microcontroller. It allows the development of IO-Link sensor systems based on the 78K0R/KE3-L device. The 
board is prepared to be connected to user hardware parts, and contains elements to easily start and 
demonstrate IO-link sensor applications. This includes I/O-functions, i.e. navigator switch, a Temperature 
sensor, MR Sensor, I/O lines, analog inputs and outputs, UART serial interface and more.  

The hardware environment, the applications, will be described in this manual. 

A sample Demo illustrating an IO-Link temperature sensor is available. 

1.1 Package contents  

  Link It! board  

  USB cable  

  24V power supply 

  CD-ROM containing the evaluation version of the TMG IO-Link Stack library, an evaluation copy of the 
IAR Embedded Workbench for 78K with 16Kbyte code size limitation, documentation, and a XML device 
description file “IO-Link user Interface" to support the Temperature demo in the TMG IO-Link Device tool. 

Please verify that you have received all parts listed in the package contents list attached to the 78K0R-Link 
It! demonstration kit package. If any part is missing or seems to be damaged, please contact the dealer from 
whom you received your 78K0R-Link It! 

1. The Technologie Management Gruppe, TMG (Technologie und Engineering GmbH)
stack is for evaluation purposes only. For mass production end products, a full 
license must be purchased from TMG. 

2. The TMG IO-Link Master and TMG IO-Link device Tool are referenced in this 
manual. However , they are not included in the package 

Please contact TMG directly for details on obtaining the full license, the TMG IO-
Link Master and TMG IO-Link device Tool 

Technologie Management Gruppe-Karlshrue ((Technologie und Engineering GmbH) 

Notes 

Internet: www.tmg-karlshrue.de

3. Please also note that the M12 cable shown in this manual is not included in the 
package. 

1.2 Features  

  NEC Electronics µPD78F1009 low power consumption general purpose NEC 16-bit 78K0R MCU  

  NEC Electronics µPD78F0730 MCU with on-chip USB interface  

   E98110A Elmos IO-Link Transceiver 

  4 x 7 segments LEDs driven by serial interface. 

  Power Supply by USB interface, external power supply, or M12 cable. 

  On-Board debug function (TK-78K0R debugger) 
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The 78K0R–Link It! board supports an On-Board debug function by using the IAR C-SPY debugger 
without a need of additional debug hardware. It allows FLASH downloading and standard debug 
functions like code execution, single stepping, breakpoints, memory manipulation etc. 

  The IAR Embedded Workbench for 78K and the IAR C-SPY debugger / simulator are included. These 
packages are restricted in such that maximum program code size is limited to 16 Kbyte.  

  Full documentation is included for the NEC 78K078F1009 microcontroller, NEC 78K0 78F0730 
microcontroller, IAR Systems Embedded Workbench and IAR Systems C-SPY debugger / simulator.  

  TMG IO-Link Stack Library (Evaluation version). 

  IO-Link communication 

The 78K0R–Link It! board provides an IO-Link communication channel  

Current type:   - DC 
Wiring:    - 3-Wire 
Output signal:   - IO-Link 
Rated operational voltage: V 24DC   
Supply voltage:   V 18…30 DC 
Short circuit protection:  - yes 
Protected against polarity rev: - yes 

 

 

IO-Link Data 

Physical Layer:    PHY2 
Data Transfer Rate:  - COM1 (4.8kBaud), COM2 (38.4kBaud), COM3 (230.4kBaud) 

  Board size: 135mm x 60mm 

  Power supply by USB interface option for Microcontroller. 

  Analog to digital signal conversion 

  Various input / output signals available, such as 

  I/O ports prepared to be connected to user hardware 

  Timer input / output signals 

  Two or three wires serial I/O 

  Analog input lines 

  Navigation switch 

  Virtual UART interface, via the µPD78F0730 78K0 8-bit microcontroller with on-board USB interface 

  The IAR Embedded Workbench for 78K and the IAR C-SPY debugger / simulator are included. These 
packages are restricted in such that maximum program code size is limited to 16 kByte. 

  Full documentation is included for the NEC 78K0R/KE3-L microcontroller, IAR Systems Embedded 
Workbench and IAR Systems C-SPY debugger / simulator. 

The 78K0R–Link It! is not intended for code development. NEC does not allow and does not support 
in any way any attempt to use 78K0R–Link It! in a commercial or technical product. 
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1.3 System requirements  

HOST PC  A PC supporting Windows 2000 or Windows XP is required for the IAR 
systems Embedded Workbench demo-version. A Pentium processor with at 
least 1 GHz CPU performance, with at least 256 Mbytes of RAM, allowing 
you to fully utilize and take advantage of the product features. 500 Mbytes 
of free disk space, and an additional 10 Mbytes of free disk space on the 
Windows system drive.  

A web browser and Adobe Acrobat Reader to be able to access all the 
product documentation. 

Host Interface  USB interface that enables communication based on USB (Ver1.1 or later) 

 

Notes 
Updates of the IAR Embedded Workbench for 78K, documentation and/or utilities for 
78K0R -Link it!, if available, may be downloaded from the NEC WEB page(s) at: 
http://www.eu.necel.com/update?id=307

1.3.1 Optional system requirements 

User may choose to purchase the following additional equipments for the development of IO-Link 
applications: 

  TMG USB IO-Link Master 

  PC software- TMG IO-Link Device Tool for configuration and analysis. 

Please contact TMG directly for details on the TMG IO-Link Master and TMG IO-Link device Tool 

Internet: www.tmg-karlshrue.de

  Double Ended 4 pins M12 cable. 

1.4 Trademarks 

IAR Embedded Workbench, visualSTATE, IAR MakeApp and C-SPY are registered trademarks of IAR 
Systems AB. Microsoft and Windows are registered trademarks of Microsoft Corporation. Adobe and 
Acrobat Reader are registered trademarks of Adobe Systems Incorporated. 
All other product names are trademarks or registered trademarks of their respective owners. 
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CHAPTER 2 78K0R–LINK IT! SYSTEM CONFIGURATION 

The IO-link standard is a point to point based communication, where a master and a slave device exchange 
information over a communication channel. The master initiates and organizes the data exchange. The slave 
treats the master’s request and replies accordingly. 

The 78K0R–Link It! board (slave device) is based on the NEC’s latest 16-bit 78K0R/KE3-L microcontroller 
family 

Figure 2-1. IO-Link system configuration 

2.1 78K0R–Link It! board 

78K0R–Link It! board is a demonstration kit for the 78K0R/KE3-L 16-bit microcontroller of the 78K0R family. 
The IO-link board can be used in two modes: IO-Link Mode (default mode), and Standalone mode. 

2.1.1 IO-Link Mode 

When used in IO-Link Mode, the 78K0R–Link It! board is connected to a host system via an IO-Link Master. 
Figure 2-1 shows the board being connected to a host computer using the TMG USB IO-Link Master (not 
included: see section 1.3.1. Optional system requirements for more details).The Master powers and 
connects to the demonstrator board via the M12 connector using a M12 cable (not included). The board will 
be working as an IO-link sensor demonstrating the application stored in the Microcontroller’s memory. 

2.1.2 Standalone Mode 

When the board is not used in an IO-link application, the board is in “standalone mode”. In this mode, the 
user can use the microcontroller for application development and debugging. The demonstration board is 
connected to the host system via USB interface with USB cable provided, See. Figure 2-2. The host system 
may be used for On-Chip debugging by using the IAR C-SPY debugger and to allow execution of application 
programs on 78K0R–Link It! board. It is also used to power the board. 
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Caution 
In “standalone mode”, the M12 cable must be disconnected and an AC adapter 
may be used to power the board if more than 500mA (USB maximum current load) 
is required  

Remark The user can optionally use an external AC adapter, the MINICUBE2(not included), or the 
USB interface, to provide power to the board. See Table 3-1. Power supply selector, JP1 
configuration for details 

The microcontroller on the board can run at up to 20 MHz operating speed. The sub-clock is provided with a 
32.768 kHz. A 18.432MHz external crystal is also available as main clock. 

Figure 2-2. USB Powered configuration 

2.2 Host computer 

The USB host interface enables communication to the 78K0R–Link It! board. The µPD78F0730, 78K0 8-Bit 
microcontroller with on-chip USB interface and the NEC virtual UART driver allows application software to 
access the USB device in the same way as it would access a standard RS232 interface. The NEC virtual 
UART driver appears to the windows system as an extra Com Port, in addition to any existing hardware Com 
Ports. 

2.3 Power supply via USB interface 

The 78K0R-Link it! board can be powered by the USB interface. Optionally the board can be powered 
by the QB-MINI2 On-Chip debug emulator as well as an external power supply. 

Caution 
A different power source must be used to power the board if more than 500mA 
(USB maximum current load) is required  
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CHAPTER 3 78K0R–LINK IT! COMPONENTS 

The 78K0R–Link It! board is equipped with a variety of components allowing a user to develop sensor 
applications. These components include: Timer input / output signals, Two or three wires serial I/O, 7 
segments numeric displays, LEDs, Power LED, 2 push buttons for external interrupts generation (SW2 and 
SW3), Dip Switch for control of operating modes of the board, Reset button, wrap area for external user 
hardware, multi directional Joystick(SW4). 

Most I/O ports on the 78K0R/KE3-L microcontroller are prepared to be connected to user hardware.  

Several connectors are available in order to be connected to host computers, FLASH programmer or any 
external target hardware. 

Figure 3-1. 78K0R-IO-Link board Components 

3.1 Power Supply Selector JP1  

 
Figure 3-2. Power Supply Selector JP1 

Jumper JP1 is the power supply selector of the board. 

In default mode (IO-Link mode: JP1 1-4 closed) the board is powered by the IO-link Master (not included), 
via the M12 connector. The board will be working as an IO-link sensor demonstrating the application stored 
in the Microcontroller’s memory. 

If the board is not used in an IO-link application, the board is in “standalone mode”. The user can use the 
microcontroller for application development and debugging. In “standalone mode”, the M12 cable (not 
included) must be disconnected and an AC adapter may be used to power the board.  
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Additionally, if an AC adapter is not available to be used in standalone mode, the user can optionally use the 
MINICUBE2, or the USB interface, to provide power to the board. 

When powered from the M12 connector or the AC Adapter, the user can then select whether to provide the 
VDD voltage rail to the microcontroller, from the regulator output from the IO-Link transceiver or the DC/DC 
Converter available on the board. LED6 lights up when power is apply to VDD, by setting JP1. 

The table below summarizes the configuration options for the power supply selector JP1.  

Table 3-1. Power supply selector, JP1 configuration 

JP1 configuration Power Supply Source 

1-2 

 

 

Power supply from USB via connector USB1 

(5V VDD for 78K0R/KE3-L from USB1) 

 The IO-Link transceiver transmitter is disabled if 
VDD_IO is below VDD_IO_UV(Please refer to the 
E98110 datasheet  available on the CD-ROM for more 
details) 

1-3 

 

 

MINICUBE2 via OCD1 connector (Note2). 

(5V VDD for 78K0R/KE3-L from OCD1) 

IO-Link transceiver transmitter is disabled if VDD_IO is 
below VDD_IO_UV(Please refer to the E98110 
datasheet  available on the CD-ROM for more details) 

1-4 

 

M12 cable via M12 connector or AC Adaptor from Jack1 

(5V VDD for 78K0R/KE3-L from DC/DC converter: Discrete VDD) 

Internal regulator of IO-Link transceiver used by the transceiver 
only 

JP4 (pins 1 and 2) must be closed. 

1-5 

 

 

M12 cable via M12 connector  or AC adaptor via Jack1 

(5V VDD for 78K0R/KE3-L from internal regulator of IO-LINK 
Transceiver) 

1. Q1 has to be mounted on the board (Note1), 

2. JP4 (pins 2 and 3) must be closed. 

1-4, 

5-6 

 

Board Power supply from M12 via M12 connector or AC Adaptor 
via Jack1 

(Transceiver’s 5V VDD from DC/DC converter: Internal regulator of 
transceiver not used) 

1. JP4 must be opened. 

2. The Black Jumper must be moved to pins 5 and 6 

 Note 1 An additional NPN transistor (not mounted), must be used. Care must be taken 
to evaluate current consumption when choosing this transistor. If the transistor gets 
destroyed, other components connected to the 5V rail on the board may also be destroyed.  

Note2 By supplying power from the MINICUBE2, external hardware must not be connected to the 
board. Within this mode the board can operate without external power supply from USB 
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3.2 Discrete Voltage rail selector, JP2 

JP2, configures the voltage level (DVDD), provided by the DC/DC converter to power the board. The user 
has the choice between 3.3V and 5V.  

Table 3-2: DVDD, JP2 Pin configuration 

 

 

Figure 3-3.DVDD selector, JP2 

3.3 I/O port voltage control, JP3  

Use JP3 to apply 3.3V or 5V to the I/O port reference input pin EVDD of the 78K0R/KE3-L. A different 
reference voltage may also be applied by using an external power source.  

 

 

Figure 3-4. EVDD selector, JP3 

3.4 VDD Transceiver selector , JP4 

JP4 controls the transceiver’s VDD voltage usage.  

 

Figure 3-5. VDD Transceiver selector, JP4 

3.5 M12 Connector, M1 
The M12 connecter allows the board interfacing with an industrial type master device. Figure 3-6 gives the 
wiring scheme for the plug. Pin 2 is not currently used for IO-Link. This pin is connected to Test pad T43 for 
future use.  

Figure 3-6.M12 wiring scheme  

JP2 configuration Discrete VDD (DVDD) 

1-2 Closed (Default) DVDD = 5V 

2-3 Closed DVDD = 3.3V 

Table 3-3: EVDD, JP3 Pin configuration 

JP3 configuration Voltage 

1-2 Closed (Default) EVDD = VDD 

2-3 Closed EVDD = 3.3V 

Table 3-4: VDD Transceiver, JP4 Pin configuration 

JP3 configuration Voltage 

1-2 Closed(Default) internal regulator active 

2-3 
Closed 

 

external Transistor Q1 
active (not supported) 

1-2-3-4 Opened external supply of VDD:  
internal regulator inactive 
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3.6 USB interface connector, USB1  

This interface allows connecting the IAR C-SPY debugger to the board in order to use the On-Board debug 
function (TK-78K0R debugging). The TK-78K0R interface supports On-board FLASH erasing / programming 
and standard debug features like code execution, single stepping, breakpoints, memory manipulation etc.  

For standard communication to a host computer - i.e. by using a terminal program - the input/output signals 
of UART1 of the 78K0R/KE3-L device can be redirected to the USB1 connector via the µPD78F0730 USB 
microcontroller.  

The power supply of the board can also be provided by the USB1 connector.  

Figure 3-7. USB1, USB Mini-B Type Host Connector Pin Configuration  

Table 3-5. Pin Configuration of Connector USB1 

Connector USB1 Signal Name  

1 VBUS 

2 D- 

3 D+ 

4 N.C. 

5 GND 

3.7 RESET button, SW1  

SW1 is the reset button. It activates the power on reset. Switch SW1 controls the reset input signal of the 
78K0R/KE3-L microcontroller. 

Beside the reset switch, the 78K0R/KE3-L can also be reseted by the on-board debugging interface via the 
uPD78F0730 microcontroller, and by the on-chip debugging interface, via the FP1 connector. 

3.8  (INTP0) Switch, SW2 

SW2 is a push button connected to external interrupt input INTP0 of the microcontroller. This is equal to port 
“P120/INTP0/EXLVI” of the 78K0R/KE3-L device. The port may be programmed to generate the external 
interrupt INTP0.  

3.9 (INTP4) Switch, SW3 

SW3 is a push button connected to external interrupt input INTP1 of the microcontroller. This is equal to port 
“P70/KR0/SO01/INTP4” of the 78K0R/KE3-L device. The port may be programmed to generate the external 
interrupt INTP4.  
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3.10 Navigation switch, SW4 

Button SW4 is a navigation switch connected to the 78K0R/KE3-L device. It operates in four directions and 
has a center push function. When the navigation switch is moved to one of the four directions or it is pushed 
a low-level signal (Vss) is applied to the corresponding pin of the 78K0R/KE3-L device. The connection of 
SW4 to the microcontroller is shown in the table below. 

The switch can be used for sensor application parameterization  

Table 3-6. SW4, Navigation switch Pin configuration 

 

 

 

 

 

 

SW4 Pin Connection to the 
78K0R/KE3-L device 

Up P16 

Left P17 

Right P51 

Center Push P50 

Down P53 

Figure 3-8. SW4, Navigation switch 

3.11 Configuration switch, SW5  

The different operation modes of the board can be set by switch SW5/bit1-10.  

Table 3-7. Configuration switch SW5, default settings 

SW5/bit Factory settings Mode 

1 OFF Standalone and debug Mode (Note1) 

2 OFF Disable TK-78K0R debugger functions 

3 OFF Disable TK-78K0R debugger functions 

4 OFF TxD1 Disconnected from TK-78K0R debugger 

5 OFF RxD1 Disconnected from TK-78K0R debugger

6 ON SCL0 Connected to display driver 

7 ON SDA0 Connected to display driver 

8 OFF AVREF Disconnected from VDD(Note2) 

9 OFF Disable TK-78K0R debugger functions 

10 OFF Disable TK-78K0R debugger functions 

 

Notes 

1. USB cable not connected 

2. The board is shipped from factory with a 2.5V reference voltage rail applied to 
AVREF, via R40.  
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3.11.1 Standalone / debug mode selection, SW5/bit1  

Switch SW5/bit1 controls the operation mode of the board, when a USB cable is connected to USB1, and the 
TK-78K0R Debugger is used. 

  Switch SW5/bit1 to ON sets the board to “stand-alone mode”.  

Within this mode, the 78K0R/KE3-L RESET can be controlled by the user via switch SW1 and by the 
IAR C-SPY debugger. The program stored in the internal FLASH memory of the 78K0R/KE3-L 
microcontroller is executed. The usage of the On-Board debug function (TK-78K0R debugging) is 
also supported within the “stand-alone mode”.  

  Switch SW5/bit1 to OFF sets the board to the “debug mode” exclusively.  

Within this mode the 78K0R/KE3-L device is permanently held within RESET state. Only the IAR C-
SPY debugger can control the RESET signal within this mode. The RESET switch SW1 is inactive.  

Table 3-8. Operation mode selection SW5/bit1 

SW5/bit1 Mode 

ON Standalone and debug mode 

OFF Debug mode only 

 

3.11.2 On-Board debug function via USB selection, SW5/bit2 – bit3 – bit9 – bit10 

SW5/bit2 bit3, bit9 and bit10 are controlling the TK-78K0R Debugger interface with the 78K0R/KE3-L 

  Switch SW5/bit2 and bit3 ON, to enable On-Board debugging via USB.  

Within this mode a dedicated single-line UART (pin Tool0) of the 78K0R/KE3-L is connected to the 
µPD78F0730 USB microcontroller. Pin Tool0 of the 78K0R/KE3-L microcontroller is reserved for on-
board FLASH programming and debugging purpose.  

  Switch SW5/bit2 and bit3 OFF to disconnect the single-line UART from the µPD78F0730 USB 
microcontroller.  

Within this mode, no debugging is supported. The user can establish standard serial communication 
via UART1 to a terminal program running on the HOST PC (see section 3.11.3 for more details).  

  Switch SW5/bit9 controls the RESET signal of the TK-78K0R debugger  

  Switch SW5/bit10 controls the FLMDO signal of the TK-78K0R debugger  

Switch SW5/bits 9 and 10 ON, only when the TK-78K0R debugger is used 

Table 3-9. (TK-78K0R debugging) configuration, SW5/bit2 - bit3 – bit9 – bit10 

SW5/bit2 - bit3 - bit9 - bit10 Mode 

OFF Disable TK-78K0R debugger functions 

ON Enable TK-78K0R debugger functions 
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3.11.3 UART mode selection, SW5/bit4-bit5  

The user can establish standard serial communication via UART1 to a terminal program running on the 
HOST PC.  

  Switch bit4 and bit5 of SW5 ON or OFF to respectively connect or disconnect the UART1 signals 
RxD1 and TxD1 of the 78K0R/KE3-L, to the µPD78F0730 USB microcontroller.  

Within this mode, standard serial communication to a terminal program running on the HOST PC can 
be established.  

Note:  when communication with the Host PC is required, the user must ensure the On-board 
debugging function is disabled (see section 3.11.2 for more details). 

Table 3-10. UART mode selection, SW5/bit4-bit5 

SW5/bit4 SW5/bit5 Mode 

OFF OFF Disconnect UART1 signals from TK-78K0R debugger 

ON ON Connect UART1 signals to TK-78K0R debugger 

 

3.11.4 Display Driver control, SW5/bit6-bit7  

Switch SW5/bit6-bit7 control the I²C interface between the 78K0R/KE3-L and the 7-segments displays driver. 

  Switch bit6 and bit7 ON or OFF to respectively connect or disconnect the display driver to the 
78K0R/KE3-L.  

Table 3-11. Display Driver control, SW5/bit6-bit7 

SW5/bit6 SW5/bit7 Mode 

OFF OFF Disconnect 7-segments display driver 

ON ON Connect 7-segments display driver 

Caution The Display driver must be powered when the 7-segment displays are used to display 
information. Please refer to section 3.13 for more details. 

3.11.5 AVREF control, SW5/bit8  

Switch SW5/bit8 controls the voltage reference source for the analog input of the 78K0R/KE3-L 

  Switch bit8 ON or OFF to respectively apply or disconnect VDD to AVREF.  

Table 3-12. AVREF control, SW5/bit8 

SW5/bit8 Mode 

OFF AVREF disconnected from VDD (Note1) 

ON AVREF = VDD 

Notes 
1. The board is shipped from factory with a 2.5V reference voltage rail applied to 

AVREF, via R40.  
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3.12 Transceiver Configuration Switch SW6 
SW6 serve two purposes. 

  It allows to isolate the IO-Link transceiver from the 78K0R/KE3-L microcontroller by disconnecting 
the communication interface 

  It put the DC-DC converter in power down mode when it is not needed by the user 

Please refer to the coming sections for more details on SW6. 

3.12.1 DC-DC power down control, SW6/bit1 

The IO-Link master provides a 24V voltage rail to the board. A DC/DC converter steps down that voltage to 
provide the 5V, and 3.3V power supplies for the board. 

The board is equipped with dual current mode PWM step-down DC/DC converter with internal power 
switches capable of generating two 1.4A outputs. Switch SW6/bit1 turns DC-DC converter ON/OFF.  

Table 3-13. DC-DC power down control, SW6/bit1 configuration 

SW6/Bit1 Setting DC-DC Converter 

1 ON DC-DC converter active 

1 OFF DC-DC converter inactive 

 

LED8, lights up when power switch SW6/bit1 is ON to indicate that the DC–DC converter is active. 

3.12.2 Transceiver bypass control, SW6/bit2-8  

Switch SW6/bit2to bit8 allow the user to connected/disconnect the IO-Link transceiver to/from the 
78K0R/KE3-L microcontroller. 

Table 3-14. Transceiver bypass control, SW6/bit2-bit8 Pin configuration 

SW6 Bit Setting IO-Link Transceiver 78K0R/KE3-L pin  

2 ON/OFF VDD_IO EVDD connected / disconnected 

3 ON/OFF TxEN P76/KR6 connected / disconnected 

4 ON/OFF SPEED P77/KR7 connected / disconnected  

5 ON/OFF TxD TxD0 connected / disconnected  

6 ON/OFF RxD RxD0 connected / disconnected 

7 ON/OFF WAKE P72/INTPU6 connected / disconnected  

8 ON/OFF ILIM P71/INTPU5 connected / disconnected 
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3.12.3 IO-Link Transceiver 

The transceiver has two functions. It is used firstly as an IO-Link port Analog front-End. It ensures the analog 
front end of the IO-Link communication channel by transforming the 3-wire 24V of the M12 IO-link port to a 
digital interface for the 78K0R/KE3-L device.  

Secondly, it can be used as a power supply source:  

The communication and the power supply run via 3 separate lines to the IO-Link Master. The integrated 
voltage regulator is able to provide up to 5mA current for external purposes. With an optional external boost 
transistor (not mounted on the board), it is possible to supply external devices with a higher current 
consumption.  

Caution The user must be aware of the current consumption of the application and the maximum 
current rate of the boost transistor, if using this feature. Since a destruction of the boost 
transistor, may also cause the destruction of other devices connected to the 5V voltage 
rail provided by the boot transistor. 

Figure 3-9. IO-Link Transceiver Block Diagram 

Further details on the transceiver can be found in the E981.10 datasheet available on the Link-It CD-ROM 

3.13 Digital logic Power Supply switch, SW7 

SW7 is a 2-bits switch used to control respectively, the power supplies (L_VDD, L_EVDD) for the 7 
segments displays driver, and the digital logic interface between the USB microcontroller (uPD78F0730) and 
the 78K0R/KE3-L.  

Switch bit1, bit2 to ON or OFF to apply or disconnect VDD and EVDD to L_VDD, and L_EVDD respectively.  

Table 3-15. SW7 Digital Logic supply configuration 

SW7/Bit1-Bit2 Setting Power supply 

ON( Factory setting) L_VDD = VDD(7-seg display and LED7 active) 
1 

OFF L_VDD Disconnected (7-seg display and LED7 inactive) 

ON L_EVDD = EVDD(USB microcontroller interface active) 
2 

OFF( Factory setting) L_EVDD Disconnected(USB microcontroller interface inactive) 
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3.14 4-digit Numeric Display 

The numeric display allows hexadecimal fonts displaying of metering information such as, distance, 
temperature, time. It is made of 4 single 7 segments displays and 5 discrete LEDs. 

Figure 3-10. 4-digit Numeric Display 

LED1 to LED3 can be used to provide common Alarm, AM, PM types of functions, or any user defined 
function. 

The colon segment LED4 and LED5 are connected in parallel and driven together as one LED.  

The 7 segments display and discrete LEDs are driven by a display driver. This display driver interfaces with 
the 78K0R/KE3-L via an I²C interface. see section 3.11.4 for details. For more details on the display driver, 
please refer to the datasheet provided on the Link-It CD-ROM. 

3.15 Power LED, LED6 

LED6, lights up when power is supplied to the 78K0R–Link It! by setting JP1.See section 3.1 for details. 

3.16 IO-Link Communication indicator, LED7 
LED7 is a bi-color LED connected to pins P42, P43, to indicate the activities on the communication channel. 

By default the LED is lighted up with an amber color, when the microcontroller is not programmed and power 
is provided to L_VDD via switch SW7 bit1. The table below shows the defined LED colors and indications for 
the board, when an IO-Link application is downloaded to the microcontroller.  

Table 3-16. LED7 indications for IO-Link port signals 

Signal IO-Link communication  

Pin 4 

"C/Q line"   Dark (OFF) :   

 not connected ) 

 Green (ON) :  (Data exchange ok ) 

  Red (ON) :     (Fault on C/Q line TX disconnected 

(Device disconnected               or  

Fault on C/Q line: Rx

 

3.17 External main oscillator, Y1 

The 78K0R/KE3-L can run at up to 20 MHz operating speed , and The clock generator can be configured to 
work with a 18.432MHz external oscillator connected between the X1 and X2 pins.  

The sub-clock is provided with 32.768 kHz to pins XT1 and XT2 of the 78K0R/KE3-L device. 
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3.18 Test pads, T1~T42 area and wrap field 
Several pins of the 78K0R/KE3-L microcontroller are connected to the test pads T1~T42 area. The 
corresponding assignment can be found in tables below. Additionally the 78K0R-Link it! board provides 
a wire wrap field area allowing the integration of additional application hardware. 

VDD, GND, and an MR sensor are also available this area. 

Figure 3-11.Test pad area and wrap field 

Table 3-17. Test Pads Tables

Test 
pads 

78K0R/KE3-L 

I/O pin 

T1 P140 / PCLBUZ0 

T2 P141 / PCLBUZ1 

T3 P00 / TI00 

T4 P01 / TO00 

T5 P20 / ANI0 

T6 P21 / ANI1 

T7 P22 / ANI2 

T8 P23 / ANI3 

T9 P24 / ANI4 

T10 P25 / ANI5 

T11 P26 / ANI6 

T12 P27 / ANI7 

T13 P150 / ANI8 

T14 P151 / ANI9 

T15 P152 / ANI10 

T16 P153 / ANI11 

T17 P80 / CMP0P / 
INTP3 / PGAI 

T18 P81 / CMP0M 
 

Test 
pads 

78K0R/KE3-L 

I/O pin 

T35 P33 

T36 P32 / SCK10 /SCL10 
INTP2 

T37 P31 / SI10 / RxD1 / 
SDA10 / INTP1 

T38 P30 / SO10 / TxD1 

T39 P61 /SDA0 

T40 P60 / SCL0 

T41 P42 

T42 P43 

T43 Pin2 M12 connector 

T44 ILIM Transceiver 

T45 WAKE Transceiver 

T46 RxD Transceiver 

T47 TxD Transceiver 

T48 SPEED Transceiver 

T49 TxEN Transceiver 

T50 VDD_IO Transceiver 

T51 AVREF 

Test 
pads 

78K0R/KE3-L 

I/O pin 

T19 P82 / CMP0M /. INTP7 

T20 P83 / CMP1M 

T21 P10 / TI02 / TO02 

T22 P11 / TI03 / TO03 

T23 P12 / TI04 / TO04 / 
RTCDI / RTCLL 

T24 P13 / TI05 / TO05 

T25 P14 / TI06 / TO06 

T26 P15 / TI07 / TO07 

T27 P52 / RTC1HZSL / 
STLI / SLTO 

T28 P71 / KR1 / SIO1 / 
INTP5 

T29 P72 / KR2 / SCK01 / 
INTP6 

T30 P73 / KR3 / SO00 / 
TxD0 

T31 P74 / KR4 / SI00 / 
RxD0 

T32 P77 / KR7 

T33 P76 / KR6 

T34 P75 /  KR5 / SCK00 
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3.19 MR (magneto-resistive) Sensor 

A MR sensor is a magneto-resistive sensors integrated circuits in small packages. It can be used in position 
detection applications, using non-contact type sensor. The MR sensor outputs a digital signal to pin 
P32/SCK10/SCL10/INTP2 of the 78KR0/KE3-L device 

3.20 Temperature sensor 

For temperature measurement and primarily as an application example, the 78K0R–Link It! board is 
equipped with a temperature sensor IC. The output pin of the temperature sensor is connected to pin 
P153/ANI11 of the 78KR0/KE3-L device. 

3.21 PG-FP4 /PG-FP5 / QB-MINI2 connector, FP1  

Connector FP1 (not mounted) allows connection of the PG-FP4/PG-FP5 FLASH programmers to the board 
in order to program application software into the 78K0R/KE3-L internal flash memory.  

Remark , The PG-FP4 /PG-FP5 FLASH programmers are separate product from NEC and are not 
included in this package. 

Additionally, FP1 allows connection of the QB-MINI2 (MINICUBE2 On-Chip debug emulator) to the board in 
order to use On-Chip debug function of the 78K0R/KE3-L device and program the internal flash memory.  

Table 3-18. FP1 pins description 

 
FP1 pin Function 

1 GND 

2 RESET 

3 SI 

4 EVDD 

5 SO 

6 N.C. 

7 N.C. 

8 N.C. 

9 N.C. 

10 N.C. 

11 N.C. 

12 N.C. 

13 N.C. 

14 FLMD0 

15 RESET_IN 

16 CLK_IN 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3-12. FP1, PG-FP4/PG-FP5/Minicube 2 connector 
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CHAPTER 4 FLASH PROGRAMMING 

Flash programming is used to download applications to the internal memory of the 78K0R/KE3-L 
microcontroller. 

This chapter covers the board settings required to perform this operation. 

On-chip debugging is documented in the next chapter: Chapter 5. On-Chip debugging

4.1 Flash Programming via MINICUBE2 (QB-MINI2) 

When using PG-FP4/PG-FP5 for FLASH programming or QB-MINI2 for FLASH programming /debugging 
purposes, please configure switch SW7 and SW5 of the 78K0R–Link It!  board as referenced the following 
tables  

Set the Jumpers on the board as shown on Figure 4-1: JP1 (VDD=OCD1), JP3 (EVDD=VDD) 

JP2 and JP4 are not required if the QB-MINI2 is used to power the board. 

Figure 4-1. Flash Programming via QB-MINI2 

Caution The maximum rating current of the MINICUBE2 is 100mA, therefore do not use MINICUBE2 
with the target system with the higher current rating.  

For applications requiring higher current rate than the maximum rate of the QB-MINI2, please use the power 
select switch on the Q-MINI2 to set the power supplied to the target system, and use an external power supply to 
power the board. 

Figure 4-2 shows JP1, JP2, JP3, jumper settings used in this configuration: 

  The Red Jumper is placed on DVDD as power will be provided by the DC DC converter. 

  The Green jumper is placed between EVDD and OCD1 to provide Q-MIN2 with  reference voltage 

  JP3(EVDD=VDD) 

  JP2 can be set to 3.3V or 5V 
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Figure 4-2.Jumper settings for flash programming in high current applications 

For more details on the QB-MINI2, please refer to the QB-MINI2 user’s manual. 

Table 4-1. SW7 configuration for flash programming/On Chip Debugging via QB-MINI2 

SW7/Bit1-2 Setting Power supply 

1 ON/OFF (*) L_VDD = VDD/Disconnected 

2 OFF L_EVDD = Disconnected 

(*) = individual selectable by user 

Table 4-2. SW5 configuration for FLASH programming via QB-MINI2 

SW5 Bit Setting Mode 

1 ON/OFF (*) Standalone and debug mode /debug mode only 

2 OFF Disable TK-78K0R debugger functions 

3 OFF Disable TK-78K0R debugger functions 

4 ON/OFF (*) TxD1 connected / disconnected 

5 ON/OFF (*) RxD1 connected / disconnected 

6 ON/OFF (*) SCL0 connected / disconnected 

7 ON/OFF (*) SDA0 connected / disconnected 

8 ON/OFF (*) AVREF applied/not applied 

9 OFF Disable TK-78K0R debugger functions 

10 OFF Disable TK-78K0R debugger functions 

(*) = individual selectable by user 

4.2 Flash Programming via TK-78K0R debugger  

Please refer to Chapter 10.  How to use WriteEZ4 FLASH programming software, for information on 
setting the board for flash programming using the TK-78K0R debugger. 
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CHAPTER 5 ON-CHIP DEBUGGING 

The 78K0R–Link It! board offers two possibilities to use On-Chip debugging (OCD).  

The board supports the QB-MINI2 On-Chip debug emulator in order to use the On-Chip debug function of 
the 78K0R/KE3-L device. The system configuration for On-Chip debugging is shown in figure below.  

Alternatively, the TK-78K0R On-Board debugger allows On-Chip debugging without a need of external 
debug hardware. Within this mode the default USB connection to the Host computer based on the virtual 
UART driver is used as debug interface. All standard debug functions are available in the On-Board 
debugging mode like FLASH programming / downloading, code execution, single stepping, breakpoints, 
memory manipulation etc.  

Figure 5-1. On-Chip debugging 

5.1 OCD via QB-MINI2 emulator  

To operate the board together with the QB-MINI2 On-Chip debug emulator, switch SW5 must be configured 
as in the following table: 

Table 5-1. SW5 configuration for On-chip Debugging via QB-MINI2 

SW5 Bit Setting Mode 

1 ON/OFF (*) Standalone and debug mode /debug mode only 

2 OFF Disable TK-78K0R debugger functions 

3 OFF Disable TK-78K0R debugger functions 

4 ON/OFF (*) TxD1 connected / disconnected 

5 ON/OFF (*) RxD1 connected / disconnected 

6 ON/OFF (*) SCL0 connected/ disconnected 

7 ON/OFF (*) SDA0 connected/ disconnected 

8 ON/OFF (*) AVREF applied/ not applied 

9 OFF Disable TK-78K0R debugger functions 

10 OFF Disable TK-78K0R debugger functions 

(*) = individual selectable by user 
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5.2 OCD via TK-78K0R On-Board debug function  

To operate the board within the On-Board debug mode, switch SW5 and SW7 must be configured as in the 
following table: 

Table 5-2. SW5 Configuration for OCD via TK-78K0R  

SW5 Bit Setting Mode 

1 ON/OFF (*) Standalone and debug mode /debug mode only 

2 ON Enable On-Board debug function 

3 ON Enable On-Board debug function 

4 OFF TxD1 disconnected 

5 OFF RxD1 disconnected 

6 ON/OFF (*) SCL0 connected/ disconnected 

7 ON/OFF (*) SDA0 connected/ disconnected 

8 ON/OFF (*) AVREF applied/not applied 

9 ON Enable TK-78K0R debugger functions 

10 ON Enable TK-78K0R debugger functions 

(*) = individual selectable by user 

Table 5-3. SW7 configuration for OCD via TK-78K0R  

SW7/Bit1-2 Setting Power supply 

1 ON/OFF (*) L_VDD = VDD/Disconnected 

2 ON L_EVDD = EVDD 

(*) = individual selectable by user 
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CHAPTER 6 780R – LINK IT! INSTALLATION AND OPERATION  

6.1 Getting Started 

The IAR Embedded Workbench including the C-SPY debugger allows building and downloading application 
programs to the 78K0R-Linking it! Development kit.  

Additionally the WriteEZ4 FLASH programming software can be used for simple FLASH programming of the 
78K0R/KE3-L internal FLASH memory.  

As communication interface between the PC host system and the 78K0R-Link it! board a standard USB 
interface line is needed. Before you can download, debug or execute an application program, hardware and 
software must be installed properly. 

6.2 CD-ROM contents  

The CD-ROM shows the following directory structure: 

Table 6-1. 78K0R–Link It! CD-ROM contents 

 78K0R–Link It!  CD-ROM ROOT 

 Acrobat  Acrobat Reader for 32Bit Windows OS  

 Device file package  µPD78F100964 Device file package 

 Doc Documentation  

 Drivers USB driver files  

 IAR Systems IAR Embedded Workbench for 78K  

IAR visualSTATE  

 SamplePrograms 

 

Sample programs for the 78K0R-Link It! Starter Kit 

  IO-Link Temperature sensor demonstration 
Program 

  Quick start empty project 

 WriteEZ4 Flash Programmer WriteEZ4 incl. PRM file for 
µPD78F1009 
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CHAPTER 7 HARDWARE INSTALLATION  

After unpacking the 78K0R–Link It! development kit, connect the board via connector USB1 to your host 
computer using the provided USB interface cable. When the 78K0R–Link It! board is connected, the USB 
driver needs to be installed on the host machine. Please refer to section, 8.7 USB Driver Installation for 
more details.

7.1 78K0R–Link It! Factory jumpers and switches Settings 

The picture and tables below show the factory setting for the jumpers and switches on the board. 

 

SW5 
Mode 

1 2 3 4 5 6 7 8 9 10 

ON     ON ON    
Stand-alone 

 OFF OFF OFF OFF   OFF OFF OFF 

 

SW6 
Mode 

1 2 3 4 5 6 7 8 

ON ON ON ON ON ON ON ON 
Transceiver connected

        

SW7 
Mode 

1 2 

 ONDisplay ON 

 OFFUSB Interface OFF
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CHAPTER 8 SOFTWARE INSTALLATION  

The 78K0R–Link It! package comes with the following software packages:  

  IAR Systems Embedded Workbench for 78K 16Kbyte code size limited, including C compiler, assembler, 
linker, librarian and IAR C-SPY debugger / simulator  

  IAR Systems Visual State time limited demo program  

  Device file package of µPD78F1009 for IAR Embedded Workbench for 78K  

  WriteEZ4 flash programmer software including the PRM file for µPD78F1009  

  IO-Link Temperature sensor demonstration program 

  The XML Device Description  file for IO-Link Device Tool software 

  The USB Drivers for the 78K0R-Link It! board 

Figure 8-1. 78K0R–Link It! CD-ROM autorun.exe 
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8.1 IAR Systems Embedded Workbench for 78K installation  

To install the IAR Systems Embedded Workbench for 78K including C-SPY debugger / simulator press the 
regarding button from the Autorun of the CD-ROM provided within the 78K0R–Link It! package. The 
installation can also be started by executing the Autorun.exe program in the directory”\IAR Systems\” 
of the CD-ROM.  

When running the autorun.exe the following screen appears. 

Figure 8-2. IAR Systems Installation screen 

To install the IAR Embedded Workbench for 78K just press the regarding button “Install IAR Embedded 
Workbench ®”. The setup dialogues will guide you through the installation process. For further information 
about the IAR Embedded Workbench installation refer to the InstallationGuide.ENU.pdf in the 
directory”\IAR Systems\doc\common\doc” of the CD-ROM.  

Please make sure to install the 78K0R/Kx3-L device file package for the IAR 
Embedded Workbench, as explained thereafter, before using the IAR Embedded 
Workbench with the 78K0R–Link It! board. 

Notes 

 
8.2 IAR Systems visualSTATE Installation  

To install the IAR Systems visualSTATE press the regarding button from the Autorun of the CD-ROM 
provided within the 78K0R–Link It! package. The installation can also be started by executing the 
Autorun.exe program in the directory”\IAR Systems\” of the CD-ROM. The IAR Systems Installation 
screen will appear and the installation of IAR visualSTATE can be started by pressing the “Install 
visualSTATE ®” button. The setup dialogues will guide you through the installation process. For further 
information about the IAR visualSTATE installation refer to the “InstallationGuide.pdf” in the 
directory”\IAR Systems\vs78k” of the CD-ROM.  

 User’s Manual U19818EE2V0UM00 33 



ERROR! REFERENCE SOURCE NOT FOUND. 

8.3 Device file package of 78K0R/Kx3-L for IAR Embedded Workbench installation  

To install the device file package of the 78K0R/Kx3-L for the IAR Embedded Workbench, press the 
“Additional software” button from the Autorun of the CD-ROM provided within the 78K0R–Link It! package. 
The setup dialogues will guide you through the installation process. The installation can also be started by 
executing the EW78K_setup_78K0R-Kx3-L_V1.11.exe in the directory”\Device file package” of 
the CD-ROM.  

8.4 WriteEZ4 installation  

To install the WriteEZ4 just press the “Additional software” button from the Autorun of the CD-ROM provided 
within the 78K0R–Link It! package. The setup dialogues will guide you through the installation process. The 
installation can also be started by executing the WriteEZ4_V102_EE.exe in the directory”\WRITEEZ4” of 
the CD-ROM.  

1. Create a sub-directory PRM in the WriteEZ4 install directory. <WriteEZ4.EXE-install-path>\PRM  

2. Copy the parameter file into the sub-directory <WriteEZ4.EXE-install-path>\PRM created during GUI 
software setup 

The regarding 78F1009.prm file can be found on the CD-ROM in the folder “CD-ROM\WRITEEZ4\PRM files”

8.5 78K0R–Link It! Sample program installation  

To install the sample/demonstration programs for the 78K0R-Link it! board, press the “78K0R LINK IT 
Demonstration Program” button from the Autorun of the CD-ROM provided within the 78K0R–Link It! 
package. The setup dialogues will guide you through the installation process. The installation can also be 
started by executing “78K0R-LINKIT SamplePrograms V1.10.exe” in the directory” 
\SamplePrograms” of the CD-ROM.  

By defaults the sample programs are installed in the following path: 

C:\Program Files\NEC Electronics Tools\78K0R-Link It! SamplePrograms 

Two sample programs are provided: 

  Link_It!_Temp_demo. 

Chapter 12 This program demonstrates a temprearure sensor application. For more details please refer to 
IO-Link Temperature sensor sample. 

  Link_It!_Qucick Start  

This project is an empty project, where the IO-link stack is already integrated. This project can be used as an 
example to start an application. 

8.6 XML Device Description file installation  

To install the XML Device Description file for the 78K0R-Link it! board, press the “Additional software” button 
from the Autorun of the CD-ROM provided within the 78K0R–Link It! package. The setup dialogues will guide 
you through the installation process. The installation can also be started by executing “Link-it XML 
Device Description file V1.10.exe” in the directory”\ Link-it XML Device Description 
file” of the CD-ROM.  

By defaults the sample programs are installed in the following path: C:\Program Files\TMG 
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8.7 USB Driver Installation  

In order to use the 78K0R-Link It! board, the USB driver needs to be installed on the host machine. Install the 
driver according to the following procedure:  

Installation on Windows 2000 Page 35  

Installation on Windows XP Page 39  

8.7.1 Installation on Windows 2000  

1. When the 78K0R-Link It! board is connected with the host machine, the board is recognized by 
<Plug and Play>, and the wizard for finding new hardware is started. Click Next>. 

Figure 8-3. Found New Hardware Wizard (Windows 2000) 

2. Following the window below is displayed. So, check that "Search for a suitable driver ..." is 
selected, then click Next> 

Figure 8-4. Search Method (Windows 2000) 
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3. Check the "Specify a location" check box only, then click Next>. 

Figure 8-5. Driver File Location (Windows 2000) 

4. Locate to the folder "CD-ROM:\Driver”. 

Figure 8-6. Address Specification 1 (Windows 2000) 
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5. The setup information file “MQB2ALL.inf” is automatic selected, then click Open to proceed 
within driver installation. 

Figure 8-7. Address Specification 2 (Windows 2000) 

6. After the location of the USB driver has been specified click OK to proceed. 

Figure 8-8. Address Specification 3 (Windows 2000) 
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7. Click Next>. 

Figure 8-9. Driver File Search (Windows 2000) 

8. Click Finish to complete the installation of the USB driver. 

Figure 8-10. USB Driver Installation Completion (Windows 2000) 
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8.7.2 Installation on Windows XP  

1.  When the 78K0R-Link-It! board is connected with the host machine, the board is recognized by 
Plug and Play, and the wizard for finding new hardware is started. At first the hardware wizard 
will ask if windows should search on the windows update web, check "No, not this time" and then 
click Next> 

The 78K0R-Link-It! board is connected with the host machine, the board is recognized by <Plug 
and Play>, and the wizard for finding new hardware is started. Click Next>. 

Figure 8-11. Found New Hardware Wizard 1 (Windows XP) 

2. Check that "Install from a list or specific location (Advanced)" is selected, then click Next>. 

Figure 8-12. Found New Hardware Wizard 2 (Windows XP) 
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3. Check that "Search for the best driver in these locations." is selected. Select the "Include this 
location in the search:" check box and then click Browse. 

Figure 8-13. Search Location Specification 1 (Windows XP) 

4. Locate the folder "C CD-ROM:\Driver” and click OK. 

Figure 8-14. Search Location Specification 2 (Windows XP) 
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5. As shown below, "NEC Electronics Starter Kit Virtual UART has not passed Windows Logo 
testing to verify its compatibility with Windows XP." is displayed. Click Continue Anyway. 

Figure 8-15. Windows XP Logo Testing (Windows XP) 

6. After the installation of the USB driver is completed the window below is displayed. Click Finish 
to close the hardware wizard. 

Figure 8-16. USB Driver Installation Completion (Windows XP) 
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8.8 Confirmation of USB Driver Installation  

After installing the USB driver, check that the driver has been installed normally, according to the procedure 
below. When using the Save It! board the “NEC Electronics Starter Kit Virtual UART” should be present like 
in the figure below.  

Please check in the Windows "Device Manager" within the Windows Properties (“Hardware” tab), that the 
driver is installed normally. 

Figure 8-17. Windows Device Manager 
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CHAPTER 9 FLASH PROGRAMMER WRITEEZ4  

WriteEZ4 is a flash programming software to flash hex files to the related device. For installation information 
refer to the chapter 8.4.WriteEZ4 installation. 

9.1 Starting up the GUI Software 

  GUI software startup 

Select WriteEZ4.EXE from the start menu to start the WriteEZ4 GUI software. 
When the GUI software is started normally, the following screen appears. 

Figure 9-1. WriteEZ4 Startup 

This window consists of the following items: 

Table 9-1. WriteEZ4 Windows items 

Name Display Information 

Menu bar  Displays menu items executable by the 
WriteEZ4 

(displayed at the top) 

Toolbar.  Displays frequently used commands as icons. 

(displayed under the menu bar) 

Action log window  Displays an WriteEZ4 action log 

(displayed under the toolbar) 

Programmer parameter window Displays programming parameter settings. 
(Displayed to the right of the action log window). 

Status bar Displays status.. 
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9.2 Toolbar 

The toolbar contains buttons for starting the important procedures of the WriteEZ4. 

Table 9-2. Toolbar Buttons 

[Device] → [Setup] button 

 

[File] → [Load] button 

 

[Device] → [Blank Check] button 

 

[Device] → [Erase] button 

 

[Device] → [Program] button 

 

[Device] → [Verify] button 

 

[Device] → [Auto procedure(EPV)] button 

 

9.3 Menu Bar 

Depending on the actual device status and device type, some menu items may be enabled or disabled. 

9.3.1 [File] menu 

Clicking the [File] menu displays the pull-down menu as shown below. This menu mainly contains 
commands related to file operation. 

Figure 9-2. [File] menu 
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9.3.1.1 [Load] command 
The [Load] command allows you to select a program file. The selected program file is programmed 
into the flash memory of the device by executing the [Program] command or [Autoprocedure (EPV)] 
command. 

Figure 9-3. HEX File Selection Window

The file selection window for program loading displays the most recently used directory to which a user 
program has been loaded. After a user program is loaded, a checksum calculation is made and the result is 
displayed in the programmer parameter window. 

[Open button], selects a user program as a program to be written to the target device. 

[Cancel button], closes the window without selecting a program. 

9.3.1.2 [Quit] command 

The [Quit] menu is the command for terminating the WriteEZ4 GUI software. Clicking the [×] box on the top 
right side of the task bar also terminates the WriteEZ4 GUI software. 

User settings are saved in the WriteEZ4.INI file, so that the GUI software starts up next time with the same 
settings. 

WriteEZ4.INI is created in the Windows folder when Windows XP is used. 
Notes 

When Windows 2000 is used, WriteEZ4.INI is created in the Winnt folder 

. 
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9.3.2  [Device] menu 

Clicking the [Device] menu displays the pull-down menu as shown below. This menu mainly contains 
commands for programming operations such as deletion, programming, and verification on the target device. 

Figure 9-4. [Device] menu 

9.3.2.1 [Blank Check] command 

The [Blank Check] command allows you to make a blank check on the target device connected to 
the WriteEZ4. If the flash memory of the target device is erased, a blank check is terminated 
normally. If the flash memory is not completely erased, the indication "not blank" is provided. 
Before starting programming, erase the flash memory of the target device. 

9.3.2.2 [Erase] command 
The [Erase] command erases the flash memory of the target device connected to the WriteEZ4. 
While the flash memory is being erased, the progress status is displayed in the action log window 
to indicate programmer operation. The execution on the [Blank Check] command before the 
[Erase] command is executed follows the setting of 'Command options' of the Advance tab 
displayed by selecting [Device] → [Setup]. 

Upon completion of [Erase] command execution, the GUI software displays the result of executing 
the command on the target device. 

9.3.2.3 [Program] command 
The [Program] command sends a specified user program to the target device and writes the 
program to the flash memory. The execution of Verify operation for detecting an error in user 
program communication from the WriteEZ4 to the target device after the execution of the [Program] 
command follows the setting of the 'Command options' on the Advance tab displayed by selecting 
[Device] → [Setup]. 

During programming, the progress status is displayed in the action log window to indicate 
programmer operation. This progress status display window displays the progress status on target 
device programming by percentage. 

Upon completion of [Program] command execution, the GUI software displays the result of 
executing the command on the target device. 
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9.3.2.4 [Verify] command 
The [Verify] command sends a specified user program to the target device connected with the 
WriteEZ4, and performs verification against the data written to the flash memory of the target 
device. During verification, the progress status is displayed in the action log window to indicate 
programmer operation. This progress status display window displays the progress status of target 
device verification by percentage. 

Upon completion of [Verify] command execution, the GUI software displays the result of executing 
the command on the target device. 

9.3.2.5 [Security] command 

The [Security] command initiates the programming of the security flag of the target device 
connected to the WriteEZ4. Set ‘Security flag settings’ on the Advance tab of the [Device] > 

[Setup] menu. 

9.3.2.6 [Checksum] command 
The [Checksum] command reads the checksum value of the target device connected with the 
WriteEZ4. 

This value differs from the value displayed in the parameter window of the main window. 

9.3.2.7 [Autoprocedure (EPV)] command 
The [Autoprocedure (EPV)] command executes the [Erase] command, [Program] command and  
[Verify] command in succession. When a user program is to be resent to the target device for 
comparison with the data written to the flash memory of the target device because of a user 
program communication error, execute the [Program] command by selecting [Device] → 

[Setup] and specifying 'Command options' on the Advance tab, then set the automatic execution of 
the [Verify] command. 

During EPV execution, the progress status is displayed in the action log window to indicate 
programmer operation. For a selected command, its execution operation, and messages, refer to 
Chapter 10. 

Upon completion of [Autoprocedure (EPV)] command execution, the GUI software displays the 
result of executing the command on the target device. 

9.3.2.8 [Signature read] command 
The [Signature read] command reads the signature information (device name, flash memory 
information, and so forth) of the target. 

9.3.3 [Setup] command 

The [Setup] menu allows you to make settings related to flash memory rewriting according to the 
user environment and to set command options. Each time the GUI software is started, the most 
recently used parameter file (.PRM) is read and the settings are displayed. The [Setup] menu 
allows you to modify the settings of items other than those items consisting of shadowed 
characters according to the user environment. 

9.3.3.1 Standard setup 

This menu is used to set the environment for rewriting the flash memory of the target device.  

The mode of communication with the target, the operating clock, and so forth differ depending on the 
device used. For details, refer to the manual of the device used, when making settings. 
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The window shown below is opened. 

Figure 9-5. Device Setup Window - Standard 

This window shows all basic options that can be set in accordance with the user environment and target 
device. 

[OK button]: Clicking the OK button saves the settings on the Standard and Advance menus and closes the 
window. 

[Cancel button]: Clicking the Cancel button closes the window without saving the settings on the Standard 
and Advance menus. 

9.3.3.1.1 Parameter file 
This file holds parameters and timing data required to rewrite the flash memory of the target device. 
Do not modify the data in the parameter file because the data is related to the guarantee of rewrite 
data. 

The parameter file is protected by the checksum function. If the checksum result indicates an error, 
the WriteEZ4 does not accept the parameter file. 

Figure 9-6. Device Setup Window - Parameter File Selection 

Figure 9-7. Parameter File Selection Window 

[PRM File Read button]: A window for specifying a parameter file is displayed. Specify a desired file 
then click Open. 
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9.3.3.1.2 Host connection 
"Host connection" is used to select a channel for communication between the 78K0R---Link It! board 
and host machine. 

Figure 9-8. Device Setup Window – Host connection 

[Port list box] 

Select a channel for communication between the 78K0R---Link It! board and host machine. 

o COM1 to COM256 

Remark Selectable ports can be checked using Device Manager. For details, refer to CHAPTER 
8.8Confirmation of USB Driver Installation

[Speed list box] 

Select a communication rate for the selected communication channel from the following: 

o 9600 bps 

o 19200 bps 

o 38400 bps 

o 115200 bps 

Remark For selectable communication rates, refer to the user's manual of the device used. 

9.3.3.1.3 Supply oscillator 
"Supply oscillator" is used to select a clock that determines programming, data transfer, and a 
transfer rate. 

Figure 9-9. Device Setup Window - Supply Oscillator Selection 

[Frequency box] 

Sets the clock frequency of the target system. The range of operating frequency varies from one 
device to another. So, check the specifications of the device used before making a setting. 
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[Multiply rate] 

Specifies the division rate or multiplication rate of the target device. If the target device has an on-
chip PLL circuit, enter a division rate or multiplication rate according to the use environment. The 
selectable division rate or multiplication rate differs depending on the device.  

Check the specifications of the device used before making a setting. 

If the target device does not have an on-chip PLL circuit, select "1.0". 

On the initial screen, the default setting is displayed according to the parameter file. 

9.3.3.1.4 Operation Mode 
The setting of "Operation Mode" may divide the flash memory of some target devices into blocks or 
areas. 

This menu is used to select an operation mode of the flash memory. Some devices do not have the 
block and area division modes, and some devices have only one of the modes. In these cases, a 
nonexistent mode is not selectable. 

Figure 9-10. Device Setup Window - Operation Mode 

[When Chip is selected] 

The entire flash memory area of the target device is subject to rewrite processing. 

[When Block is selected] 

Specify the Block number range subject to rewrite processing by using Start/End. 

The Start/End list boxes display the Block numbers where the flash memory of the 

target device is configured. 

[When Area is selected] 

Specify the Area number range subject to rewrite processing by using Start/End. 

The Start/End list boxes display the Area numbers where the flash memory of the 

target device is configured. 

[Show Address check box] 

Specify whether numbers or addresses are displayed in the Start/End list boxes. 

If this check box is checked, addresses are displayed. 

If this check box is not checked, numbers are displayed. 
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9.3.3.1.5 Target Reset Message 
By checking the Target Reset Message check box, the window promoting the reset operation 
manually is displayed even when the reset signal cannot be connected to the target cable. 

Figure 9-11. Device Setup Window – Target Reset Message 

9.3.3.2 Advance setup 
The Advance setup menu is used to specify the command options and security flag settings. 

When "Advance" is clicked, the following window is displayed: 

Figure 9-12. Device Setup Window – Advance 

9.3.3.2.1 Command options 
This dialog box is used to specify the WriteEZ4 flash processing command options. 

Figure 9-13. Device Setup Window - Command options 

[Blank check before Erase check box] 

If this check box is checked, blank check is made before the Erase command or EPV command is 
executed. 

If the result of a blank check indicates OK, erase processing is not executed. 

[Read verify after Program check box] 

If this check box is checked, write data is sent from the programmer after execution of the Program 
command and EPV command, then the data is verified against the data written to the flash memory. 
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[Security flag after Program check box] 

If this check box is checked, automatic programming of the selected security flag is executed after 
execution of the [Program] and [Autoprocedure (EPV)] commands. 

[Checksum after Program check box] 

If this check box is checked, the flash memory checksum value of the target device is read from the 
target device after execution of the Program command and EPV command. 

This value differs from the value displayed in the parameter window of the main window. 

9.3.3.2.2 Security flag settings 
The <Security flag settings> dialog box is used to specify which security function is valid. 

Figure 9-14. Device Setup Window – Security flag settings 

Caution The following table is the correspondence between the [Erase] and [Program] Commands 
when the security functions of a 78K0R/KE3-L microcontroller are valid! 

 Chip Erase Command Block Erase Command Program Command

Disable Chip Erase Invalid Invalid Valid (Note1) 

Disable Block Erase Valid Invalid Valid 

Disable Program Valid Invalid Invalid 

Disable Boot block 
cluster reprogramming Valid (Note2) Valid (Note2) Invalid 

1. Since the [Erase] command is invalid, the data that differs from the data 
already written in the flash memory cannot be written. Notes 

2. Valid only for the area other than the area specified as the boot area 

[Disable Chip Erase check box] 

If this check box is checked, the [Erase] command becomes invalid in the entire flash memory area of the 
target device. 

At this time, the warning message shown below is displayed. 

Figure 9-15. Device Setup Window – Disable Chip Erase  
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Caution Be aware that if the security flag is set in the target device, neither erasing nor writing to 
the device can be enabled afterward!!! 

[Disable Block Erase check box] 

If this check box is checked, the [Erase] command becomes invalid in all the blocks of the flash memory 
selected under Operation Mode in the Standard Setup menu. This setting is cleared by the [Erase] command 
when Chip was selected under Operation Mode. 

[Disable Program check box] 

If this check box is checked, the [Program] command becomes invalid, as does the [Erase] command in all 
the blocks of the flash memory selected under Operation Mode in the Standard Setup menu. 

The [Erase] command for the entire flash memory area is valid. This setting is cleared by the [Erase] 
command when Chip was selected under the Operation Mode. 

[Disable Boot block cluster reprogramming check box] 

If this check box is checked, the boot area is set with the boot block set in the Boot block Cluster setting as 
the last block. At this time, the warning message shown below is displayed. 

Figure 9-16. Device Setup Window – Disable Boot Cluster Reprogramming warning 

Caution Be aware that if the security flag is set in the target device, the boot area cannot be 
rewritten to the device afterward!!! 

9.3.4 [View] menu 

Clicking the [View] menu displays the pull-down menu shown below. 

This menu contains commands for setting whether to display the toolbar and status bar. 

Figure 9-17. [View] Menu 

9.3.4.1 [Toolbar] command 
Checking the [Toolbar] command displays the toolbar. Unchecking the command hides the toolbar. 

9.3.4.2 [Status Bar] command 

Checking the [Status Bar] command displays the status bar. Unchecking the command hides the status bar. 
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9.3.5 [Help] menu 

Clicking the [Help] menu displays the following pull-down menu: 

Figure 9-18. [Help] Menu 

9.3.5.1 [About WriteEZ4] command 

The [About WriteEZ4] command opens the program entry window as shown below and indicates the version. 

Clicking OK terminates the display. 

Figure 9-19. About WriteEZ4 Window 
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9.4 Programmer Parameter Window 

This window displays the settings of the programming parameters. 

Figure 9-20. Programmer Parameter Window 

[Device] 

Updated after communication with the target device to display information about the target device. 

[Parameter file] 

Updated after [Setup] command execution to display information about a read parameter file. 

[Load file] 

Updated after [Load] command execution to select information about a selected program file. 

[Connection to device] 

Updated after [Setup] command execution to display information about the connection with the target device. 
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CHAPTER 10  HOW TO USE WRITEEZ4 FLASH PROGRAMMING SOFTWARE 

This chapter explains the basic operation of the WriteEZ4 GUI for programming the 78K0R-Link it! board. It 
covers how to start the system, execute the EPV command, and program the target device. Furthermore, the 
FLASH programming of the 78K0R/KE3-L via WriteEZ4 is shown in the following pages. 

The conditions of the series of operations described in this chapter are as follows: 

Hardware configuration of 78K0R-Link it!: 

Base board: 78K0R-Link it! 

Target device: 78K0R/KE3-L (μPD78F1009) 

Clock: Internal Oscillator 

Voltage level: 5 V 

Software configuration of WriteEZ4: 

Parameter file: 78F1009.PRM 

Clock setting: Internal Oscillator 

Port: COM6 (115200 bps) 

Operation mode: Chip 

Write HEX: Linkit_Demo.hex 

Option setting: Blank check before Erase 

10.1 Installing the WriteEZ4 GUI software 

Install the WriteEZ4 GUI software on the host machine you are using, by referring to section 8.4 WriteEZ4 
installation (if the software has not been installed yet). 

10.2 Installing the driver 

Install the USB driver on the host machine you are using, by referring to section 8.7 USB Driver Installation 
(if the driver has not been installed yet). 

10.3 Installing the parameter file 

The parameter file (*.prm) for the µPD78F1009 is located on the CD-ROM, in the same folder as the 
WriteEZ4 setup file.  

Nevertheless, newest version of parameter file for the μPD78F1009 device can by download from the NEC 
Electronics Web site. 

Download the parameter file for the PG-FP4 from the following NEC Electronics Web site: 

http://www.eu.necel.com/updates

Copy the parameter file downloaded from the NEC Electronics Web site into sub-directory <WriteEZ4.EXE-
install-path>\PRM created during GUI software setup (refer to section 8.4 WriteEZ4 installation). 
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10.4 Connecting and starting 

Set the 78K0R-Link it! board to the WriteEZ4 FLASH programming mode by switching SW5, SW7  and 
jumpers JP1 to JP4 to the following setting: 

Figure 10-1. WriteEZ4 FLASH programming mode connection 

 

Table 10-1. WriteEZ4 FLASH programming mode 

SW5 SW7 
Mode 

1 2 3 4 5 6 7 8 9 10 1 2 

 ON ON   ON ON ON Don’t 
care WriteEZ4 Don’t care 

OFF   OFF OFF    

 
<Plug and Play> connect the 78K0R-Link it! board with the host machine via the USB cable. 
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10.5 Start the WriteEZ4 GUI. 

Figure 10-2. GUI Software Startup Screen 

10.6 Setting the programming environment 

Select [Device] → [Setup] from the menu bar. 

The Standard dialog box for device setup is activated. 

Figure 10-3. <Standard Device Setup> Dialog Box 
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Click PRM File Read to open the parameter file selection window. 

Select the parameter file “78F1009.prm” then click Open. 

Figure 10-4. Parameter File Selection 

From the Port list box, select the communication port that matches the host machine being used. Select the 
communication speed of the Host connection. 

Figure 10-5. Port Selection 

Remark Selectable ports can be checked using Device Manager. For details, refer to 8.8 
Confirmation of USB Driver Installation. 
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Click the OK button. The GUI software sets the parameters. 
When the settings have been completed, the following screen is displayed: 

Figure 10-6. Completion of Parameter Setting 

10.7 Selecting a user program 

Select [File] → [Load]. 

Select a program file to be written to the target device, then click Open 

Figure 10-7. After Downloading 
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10.8 Autoprocedure (EPV)] command execution 

Select [Device] → [Autoprocedure (EPV)] from the menu bar. 

When the [Autoprocedure (EPV)] command is executed, Blank Check → Erase → Program and FLASH 
Internal Verify are executed sequentially for the μPD78F1009 device. 

Figure 10-8. After EPV Execution 

After flash programming is complete, unplug the USB cable and set SW5, SW7 and the jumpers to their 
factory settings.  

However, if the board must be powered from the USB cable, switch bit 1 of SW5 to 1 to set the board in 
standalone mode, and press the reset button SW1 to run the application programmed in the microcontroller. 

10.9 Terminating the GUI 

Select [File] → [Quit] to terminate the GUI software. All settings executed so far are saved in the 
WriteEZ4.INI file, so that those settings can be reused when the GUI software is restarted. 

10.10 Restarting the GUI 

When the system is restarted, the same screen as shown in Figure 10-7. After Downloading, appears. 
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10.11 Erasing the flash memory (using the WriteEZ4)  

If a preprogrammed software has been written to the flash it is mandatory to erase the flash of the device 
before it is possible to use the IAR Embedded Workbench with the 78K0R–Link It! board. To erase the flash 
please perform following steps. 

Make sure that the 78K0R–Link It! board is in the Debugging/Writing mode: (section 10.4.Connecting and 
starting.)  

If not already connected, connect the 78K0R–Link It! board via USB1 connector to the target device.  

Run the WriteEZ4 flash programming software.  

Select [Device] → [Erase] from the menu bar, or Click the erase button  

After finishing the flash erase following message shall apply 

Figure 10-9. WriteEZ4 flash erase successful 
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CHAPTER 11 IAR EMBEDDED WORKBENCH 78K0R–LINK IT! SAMPLE PROJECT  

The IAR Embedded Workbench IDE is a very powerful Integrated Development Environment that allows you 
to develop and manage a complete embedded application project.  

The now described project can be found on the 78K0R–Link It! CD-ROM in the “\samplePrograms” folder.  

To run/debug the project with the IAR C-SPY debugger it is necessary to follow the steps described below in 
this chapter.  

For further information about the IAR Embedded Workbench ant the included functionalities please refer to 
the regarding User’s manuals available on the 78K0R– Link It! CD-ROM in the “\IAR Systems\doc” 
folder.  

The 78K0R–Link It! is shipped with the demo software programmed to the 
78K0R/KE3-L’s internal memory. Make sure that the Flash memory is erased properly 
before the first project download to the target device. Refer to section

Notes
.10.11. Erasing 

the flash memory (using the WriteEZ4). 

11.1 Hardware setup  

To run the program it is necessary to set up the 78K0R–Link It! board in the following way: 

The communication between the starter kit and the IAR C-SPY debugger running on the host computer is 
done via the standard UART / USB connection. 

To operate the 78K0R-Link it! board within the TK-78K0R On-Board debug mode, configure switches SW5 to 
SW7 and Jumpers JP1 to JP4 as instructed in the following figure and Tables: 

Figure 11-1. IO-Link and On-Chip Debugging via USB 

Figure 11-1 shows the jumper setting when the board is used for an IO-Link 
application. If you are not using the board for an IO-Link application and USB port 
power supply is sufficient for your application needs, please use the jumper setting 
from 

Notes 

Figure 10-1 and refer to section 5.2. (OCD via TK-78K0R On-Board debug 
function) for SW5, SW7 settings  
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Table 11-1. SW5 and SW7 setting for On-Chip Debugging via USB 

SW5 SW7 
Mode 

1 2 3 4 5 6 7 8 9 10 1 2 

ON ON ON   ON ON  ON ON ON ON
TK-78 On-Board debug 

   OFF OFF   OFF     
 

Table 11-2. SW6 setting for IO-Link Communication 

SW6 
Mode 

1 2 3 4 5 6 7 8 

ON ON ON ON ON ON ON ON Transceiver 
connected         

11.2 Sample Programs  

Each of the sample programs is located in a single directory, which will be called main-directory of the 
sample. This main directory of each sample contains the complete project inclusive all output files of the 
development tool. The workspace file “78K0R_LINKIT_SAMPLES.eww” is located on top of the sample 
program directories. All sample programs use the same directory structure: 

Table 11-3. Example directory structure  

78K0R-Link It! project and output files  Link_It!_Temp_Demo 

Application source files  Application 

C header files  INC 

C source files  SRC 

Board support package (ADC, I2C, Keys)  BSP 

C header files  INC 

C source files  SRC 

debug output files for IAR C-SPY debugger  Debug 

release output files, i.e. Intel HEX file  Release 

configuration files, IAR Embedded Workbench  settings 

IO-Link device stack and header files  Stack 

dependency information file, IAR Embedded Workbench  Link_It!_Temp_demo.dep 

project setting file, IAR C-SPY debugger  Link_It!_Temp_demo.ewd 

project file, IAR Embedded Workbench  Link_It!_Temp_demo.ewp 

78K0R-Link It! project and output files Link_It!_Quickstart 

workspace file, IAR Embedded Workbench 78K0/78K0S/78K0R 78K0R_LINKIT_SAMPLES.eww 

 
The main directory contains only the project files for the IAR Systems Embedded Workbench 
78K0/78K0S/78K0R.  
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All source files are located in the directories /SRC. The /INC directory contains the header files.  

Each sample project uses two targets: 

  One target is the “Debug” (directory /Debug), which holds all information for debugging purpose. 

  The other target is the “Release” target (directory /Release), which contains the programmable file, 
i.e. the Intel HEX file, for programming the 78K0R/KE3-L internal FLASH memory via PG-FP4, PG-
FP5, MINICUBE2, or TK-78K0R.  

All output files of the development tools for the corresponding target are generated in the directories /Debug 
and /Release.  

11.3 Loading the Link It! sample project  

Start the Embedded Workbench from Windows “Start” menu > “Programs” > folder “IAR Systems” > “IAR 
Embedded Workbench Kickstart for 78K”. The following screen appears: 

Figure 11-2. IAR Embedded Workbench Startup window 

In this window you are able to choose the Open existing workspace button. 
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Now select the option “Open exiting workspace” from the “File” menu and locate the sample project. Open 
the 78K0R_LINKIT_SAMPLES.eww workspace file. This is the workspace file that contains general 
information about the demonstration projects and settings.  
After the demo workspace has been opened the projects contained in the workspace are displayed. Click on 
the little “+” sign next to the “Link_It!_Temp_Demo” project to show files part of the project. 

The IDE should look similar too the figure below. 

Figure 11-3. IAR Embedded Workbench Main IDE window 

To verify that the right debugging device is chosen please open the project options window by clicking 
Project →Options and then open the tab Debugger.  

Caution Although the On-board debug interface is used, the MINICUBE C-Spy driver must be 
selected instead of the standard driver TK-78K used for other starter kits. If the debug 
session via MINICUBE2 and the OCD1 connectors shall be started, also the MINICUBE C-
Spy driver must be selected.  

The corresponding COM port where the 78K0R-Link it! board is connected to the host PC will be detected 
automatically by the IAR C-SPY debugger. 
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Figure 11-4. IAR Embedded Workbench Debugger Options 

The next step is to check that the correct linker settings are set. This can be done in the “Linker” category as 
shown below. Select the “Config” tab and check that the linker command file “lnk78f1009_64.xcl” is selected. 
This file is used by the linker and contains information on where to place the different sections of code, data 
and constants that may be used within the demo project: 

Figure 11-5. Embedded Workbench Linker Configuration 
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Now after everything has been setup correctly it’s time to compile and link the demonstration project. Close 
the Options menu and select “Rebuild All” from the “Project” menu. If the project is compiled and linked 
without errors or warnings it can now be downloaded to the 78K0R-Link It! board and debugged.  

To start the IAR C-SPY debugger select the option “Debug” from the “Project” menu or press the 
“Debugger” button.  

When first starting the debugger connection, after building the project, it is necessary to set up the right 
connection settings. Please take care that the following settings are chosen:  

  ID code = FFFFFFFFFFFFFFFFFFFF  

  Main clock = External 18.432 MHz  

  Sub clock = External 32.768 KHz  

  Target connect = TOOL0+TOOL1  

Figure 11-6. IAR Embedded Workbench MINICUBE2 settings 
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Now the debugger is started and the demo project is downloaded to the 78K0R-Link It! board. The progress 
of downloading is indicated by blue dots in the MINICUBE Emulator window. Please note that downloading 
of larger executables may take some time.  

Figure 11-7. IAR project download 

After the download was completed all debug features of IAR C-SPY debugger are available, i.e. Single 
Stepping, Step Over/-In/-Out, Go-Execution, Breakpoints, Register / Memory view etc.  

To get more details on the debugger configuration and capabilities please refer to the “78K IAR Embedded 
Workbench IDE User Guide” of the IAR installation. 

Figure 11-8. IAR C-SPY debugger 
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CHAPTER 12 IO-LINK TEMPERATURE SENSOR SAMPLE 

The demo application shows the IO-link communication protocol as well as different features present on the 
board such as the display (Teach-In), the Sensor (Temperature), the TMG Stack, the Elmos physical layer, 
analog digital conversion and more. 

The 78K0R–Link It! board is shipped with the demo preprogrammed to the microcontroller. When the board 
is connected to an IO-Link Master and communication is established, the temperature is measured and 
transmitted through IO-Link.  

For the purpose of this demo the TMG USB IO-Link Master has been used. The screenshots in the following 
section are those of the TMG device tool software, operating with the TMG master device. 

If you have the TMG Master device, a XML device description file for the 78k0R-Link-It! board demo can be 
found on the 78K0R–Link It! CD-ROM in the “\Link-it XML Device Description file” folder. For 
more details on installing the XML Device Description file, please refer to section 8.6 XML Device 
Description file installation . 

Once the Device tools software has been updated, the 78K0R-Link it! board can be controlled from the 
software GUI. For further details please refer to section 12.2 Using 78K0R-Link It! Board demo with TMG 
IO-Link Device Tool.

Connect the IO-Link Master to the host computer. The 78K0R-Link-It! board should be now connected to the 
Master via the M12 cable see Figure 2-1. IO-Link system configuration

Remark If you do not have the TMG USB IO-Link master, and your equipment does not support the 
XML description file, please refer to the “QuickStart Guide IO-Link Device Stack library” 
available on the CD-ROM for a list of indexes referring to the application’s process-data 
and parameters accessible trough IO-Link. 

Caution jumpers and switches on the 78K0R-Link-It! board must be set to their factory settings as 
described in section 7.1. 78K0R–Link It! Factory jumpers and switches Settings

12.1 Demo Features 

Once IO-Link communication is established with the Master, the board displays the current room 
temperature in 0,5 °C variation steps as per Figure 12-1. 

Figure 12-1. 78K0R–Link It! Demo display 

The current measured temperature value is displayed with 2 digits (DIG0 and DIG1).  

The decimal point behind the last digit is the 0.5°C indicator (for 28.5 °C it would be lit). 

The user can set two (Upper/Lower) thresholds, set by default to 32°C, 29°C respectively, when the board is 
connected. 
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LED1 to LED3 are alarm LEDs representing thresholds set by the user. 

  LED1 lights up when the measured temperature is above the Upper Threshold 

  LED2 lights up when the measured temperature is between the two Thresholds 

  LED3 lights up when the measured temperature is below the Lower Threshold 

12.1.1 Min/Max Temperature display 

The minimum/maximum temperatures measured since the sensor has been connected to the IO-Link master 
can be readout on the display at any time when pressing SW2 (lo: xx) for the Min Temperature, and SW3 (hi: 
xx) for the Max Temperature. XX represent the temperature in degree Celsius. 

Figure 12-2. Minimum Temperature Readout

 

Figure 12-3. Maximum Temperature Readout

 

12.1.2 Temperature thresholds setting 

 The user has the ability to set two thresholds (a Lower and an Upper threshold).  

Figure 12-4. Default Lower Threshold  

 

Figure 12-5. Default Upper Threshold 

 

1.  To enter the settings menu, press the Center button on SW4. The display thereafter shows the 
current value of the lower threshold (for example LO: 29 default). 

  Pushing the SW4 button to the right increments the lower threshold in 0,5 °C steps 

  Pushing the SW4 button to left decrements the lower threshold in 0,5 °C steps  

  Pushing the SW4 button up, increments the upper threshold it in 0,5 °C steps 

  Pushing the SW4 button down decrements the upper threshold in 0,5 °C steps 

The upper threshold can never be lower or equal to the lower threshold and vice-
versa. 

The actual set threshold temperature as well as the min/max value, are displayed 
with 2 digits only. The point behind the last digit is the 0.5 indicator (therefore for 
32.5 °C it would be lit). 

 

2. To confirm the settings, press the center button on SW4 again. The display thereafter, reverts to the 
current measured temperature display.  

All of the temperature values, thresholds values and settings can also be changed or read using the TMG 
USB IO-LINK Master device tool. 
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12.2 Using 78K0R-Link It! Board demo with TMG IO-Link Device Tool. 

The IO-Link device tool can be used for the configuration of IO-Link masters, setting and steering parameters 
as well as the diagnosis of IO-Link devices.  

IO-Link master initiates the communication, and channels information from the board to the host machine. 
The operator is able to see the information on the host machine via the installed IO-Link Device Tool. 

12.2.1 Getting started with the TMG master: 

1. Launch the IO-Link device Tool.  

2. Once the tool is up and running, two panes can be seen in the GUI (Topology on the left, and 
Catalog on the right),see Figure 12-6 

Figure 12-6. IO-Link Device Tool GUI 

The topology pane shows the topology from the PC interfaces to the IO-Link Devices 

The Catalog pane shows all the Devices installed with the tool. 

On the symbol bar, two icons (setup/exit online connection) allow to set the IO-Link line status. 

When the line is Online, the “Online status” symbol will blink green with the symbol “online” 

The common field is currently blank but it will display the description of the devices present in the Topology 
view 
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12.2.2 Updating the IO-Link Device catalog 

Before the 78K0R–Link It! can be displayed in the device tool, the IO-Link devices catalog must be updated 

1. In the Catalog pane, right click on “IO-Link Devices” and select [Actuate catalog] 

 Figure 12-7. Catalog update 

2. Press [Yes] in the small window with the message [Do you want to insert the 78K0R–Link It! 
Temperature sensor of NEC Electronics (Europe) into the catalog] 

Figure 12-8. Catalog update confirmation
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12.2.3 Catalog update confirmation 

A successful update will show the NEC Electronics (Europe) vendor and the 78K0R–Link It! Temperature 
sensor, in the IO-Link Devices section of the catalog. 

The TMG USB IO-Link master can also be seen under PC Interfaces section of the catalog. 

Figure 12-9. 78K0R–Link It! I Device catalog 

12.2.4 IO-Link communication set-up 

1.  From the Catalog pane, drag and drop the TMG USB IO-Link Master into the Topology pane.  

2. Left click on TMG USB IO-Link Master DE in the Topology pane, and the IO-Link Master’s details 
can be seen in the Common pane (centre section of the window).  

Figure 12-10. TMG USB IO-Link Master
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3. Left click on the "Setup online connection" icon in the Device Tool GUI, will show the "Check Config" 
button under "Connected Device" in the Common section. 

Figure 12-11. Online status, Check Config 

4. Click on the "Check Config" button. 

The LEDs on the Master will blink as the master tries to connect to the 78K0R–Link It! board  

  If the 78K0R–Link It! board is working and the master can connect to it, a small window will 
show with information on the board and a “Take over type of device into engineering” button. 
See Figure 12-12. Check Config successful 

  If the master cannot connect to the 78K0R–Link It! board a window with an error message 
“can’t read configuration” will appear. See Figure 12-13. Check Config failure. 

Figure 12-12. Check Config successful 

 

Figure 12-13. Check Config failure 
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Caution It can happen sometime that the “can’t read configuration” message appears in the Device 
Tool when the Master is not properly initialized. Unplugging the master from the USB port 
of the host machine and re-starting the Device tool solves this problem. Also please check 
the board settings are properly set for IO-link communication and that the board is 
properly connected to the IO-Link master.  

5. Click on the  “Take over type of device into engineering” button 

The 78K0R–Link It! board will now appear under the TMG USB IO-Link Master DE in the topology 
pane, and details on the board can be read in the Common pane 

Figure 12-14. IO-Link communication active 

 

The IO-Link communication is now active and we can have a closer look at the device and the sensor 
application running on the board 

The Common pane provides information on the connected device such as: 

  Device name: 78K0R-Link It! Temperature Sensor 

  Device ID: 0x18C000 

  Vendor name: NEC Electronics (Europe) 

  Vendor ID: 0x018C 

  Picture of the Io-Link device connected to the master 
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12.2.5 78K0R-Link It! Board sensor demo in IO-Link device tool 

In this section we see how the 78K0R–Link It! Board works with the IO-Link Master and how the demo’s 
features explained earlier can be used from the IO-Link Device tool GUI. 

 Left click on the 78K0R–Link It! in the topology pane to display generic information on the board in the 
Common pane. 

Next to the Common tab, two other tabs can be seen (Process data and Parameter) 

Figure 12-15. 78K0R–Link It! in device tool 

12.2.5.1 Common tab 
The Common pane provides information on the device such as: 

  Picture of the device  

  Device name, Product ID, Device ID, vendor name 

  Port used on the master. Here the kit is connected to port 0. 

  Device description file, its version and date of creation. 

  Device version 

  IO-Link version. 
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12.2.5.2 Process data tab 
The Process data tab displays the sensor measurements (process data inputs from the sensor). 

Figure 12-16. 78K0R–Link It! Process data 

The user can find information such as the Min/Max Temperature values, the Current Temperature, and the 
Threshold State (above, between, and below, representing LED1, LED2, and LED3 respectively). 

12.2.5.3 Parameter tab 

The Parameter tab displays the default settings of the sensor, but also enables the user to teach the sensor 
by writing new thresholds values to the board. 

From the tabs on the parameter page we can find general read only vendor specific parameters such as: 

  Vendor and product names 

  Hardware, firmware revisions 

From the tabs on the parameter page we can find read/write device specific parameters such as: 

  Upper/Lower Thresholds 

Figure 12-17. 78K0R–Link It! Parameter page
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12.2.6 78K0R-Link It! Board sensor Teach-in 

When the user opens the parameter page for the first time, the device specific parameters are set to their 
default values. 

The “Pre-adjustment” and “Value” columns match each other in the parameter page, see Figure 12-17. 
78K0R–Link It! Parameter page

The “Pre-adjustment” column displays the default sensor settings 

The “Value” column displays the current sensor settings 

12.2.6.1 Read parameter from the 78K0R-Link It! Board sensor 
To read or refresh the display of the current parameter setting from the board: 

1. Under the “Value” column, click Left in the cell corresponding to the parameter you want to read. 

The cell is highlighted in blue and the current parameter value is displayed 

 Figure 12-18 shows the reading of the lower temperature threshold of 29°C set on the board 

Figure 12-18. Lower Threshold value reading 

The same procedure is used to read the Upper threshold set on the board 
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12.2.6.2 Write parameter to the 78K0R-Link It! Board sensor 
The teach-in functionality allows changing the valid temperature range on the fly by modifying the 
Upper/Lower thresholds 

To write or teach a parameter to the board: 

1. Under the “Value” column, click Right in the cell corresponding to the parameter you want to change. 

The cell is highlighted in blue and a dialog box will open to enter the new value 

2. Enter a new value in the box and press the [Enter] key on your keyboard. 

The new parameter is now passed to the board. You can check with the SW4 joystick that the parameter has 
been passed correctly to the board. 

The Thresholds LEDs will automatically display what the current measured temperature is with regards to the 
new range.  

 Figure 12-19 shows the dialog box and the setting of the Lower threshold to 25°C. 

Figure 12-19. 78K0R- -Link It! Thresholds setting 
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CHAPTER 13 CABLES  

13.1 USB interface cable (Mini-B type) 

Figure 13-1. USB interface cable (Mini-B type) 
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CHAPTER 14 SCHEMATICS 

Schematics descriptions for the 78K0R-Link It! board. are attached to this document. 
Use the Attachments tab for access (lower left side of the screen). 
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[MEMO] 
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